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About the ABBYY Vantage Connector for UiPath
ABBYY Vantage provides content IQ skills that allow you to turn unstructured content into structured,

actionable information by means of classification and extraction, as well as processing specific

document types like invoices, orders, W2 forms, and more.

ABBYY Vantage Connector for UiPath allows you to incorporate ABBYY Vantage skills into your UiPath

workflow.

System requirements
You will need an account with ABBYY Vantage both to configure and to run your process. 

ABBYY Vantage Connector for UiPath can run on the following operating systems: 

· Windows 10

· Windows Server 2016

· Windows Server 2019

Note: The connector can't be running on computers with Windows Server 2012 R2, Windows 8.1, and
older operating systems. 

The connector for UiPath can be used with:

· ABBYY Vantage 2.3.2 or later

· UiPath Enterprise Edition 2023.8.0

· Community Edition 2023.4.4 or later 

The following external components must be installed: 

· Microsoft .Net Framework 4.7.2 or later 

· Microsoft .Net 6.0 or later

Note: We recommend that you convert Windows-legacy projects to Windows compatibility, because
legacy compatibility is no longer supported. For information on how to convert Windows-legacy projects
to Windows, see Converting Windows-legacy projects to Windows.   

Installing the Connector
ABBYY Vantage Connector for UiPath is a set of activities running on the UiPath side within the user-

defined workflow. The activities are delivered as a NuGet package.

To install the package:

1. Run ABBYYVantageConnectorForUiPath.<version>.exe and follow the instructions of the

Installation Wizard. During the installation, specify the connector installation folder. By default, it is

set to C:\Program Files\ABBYY Vantage Connector for UiPath.

2. In UiPath Studio, open an existing project or create a new one.
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3. On the ribbon, click Manage Packages on the Design tab:

4. Make sure the nuget.org package source is enabled. This package source is required in order to

install some dependencies for the connector package.

Note: If you already have a configured package source and want to use it, skip step 5. 

5. Go to the Settings tab of the Manage Packages window and create a new package source:

a. Enter a name for the new package source.

b. Specify the path to the folder where you intend to place the connector NuGet packages.

c. Click Add to confirm the settings.

The new package source is displayed in the User defined package sources area and in the left

pane of the Manage Packages window.
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6. Copy all the NuGet packages of the ABBYY Vantage Connector for UiPath from the installation

folder to your package source folder. The NuGet packages are located in the UiPath Activities

subfolder of the installation folder that was created in step 1 (the default location is C:\Program

Files\ABBYY Vantage Connector for UiPath\UiPath Activities).

After the NuGet connector packages are added to the available package source, you can install

the connector package to the project dependencies.

7. In the Manage Packages window, navigate to the All Packages section and do the following:

a. Click the newly created package source category. 

b. Select Abbyy.UiPath.Vantage.Activities from the list of available packages and click Install. 

The License Acceptance window will display licensing terms for each third-party package you

install.

c. Click on View License to read the license terms. 

d. Click I Accept to agree with the license terms and install the packages. Finally, click Save.
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8. Once installed, the Vantage activities will appear in the ABBYY Vantage section of the list of

activities available for your project:

For detailed instructions on installing packages, please refer to the UiPath Studio Guide.

Converting Windows-legacy projects to Windows

We recommend that you convert Windows-legacy projects to Windows.

Important! To convert the project to the Windows compatibility, you need to upgrade the version of
the ABBYY Vantage Connector for UiPath. To do this, perform all steps from the section Installing the
Connector except step 5.

The default compatibility for new projects is now Windows compatibility. To convert Windows-legacy

projects to Windows compatibility, you should perform the following procedure for each Windows-legacy

compatibility project:

https://docs.uipath.com/studio/docs/managing-activities-packages 
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1. In UiPath Studio, open the Windows-legacy project.

2. Click the Convert to Windows link in the message that appears under the ribbon.

The Convert to Windows dialog box will open.

3. Specify how the Windows-legacy project will be converted to Windows:

· To create a copy of the current project using Windows compatibility and keep the original

Windows-legacy project, select Create a new project. Enter the name of the project, its

desired location, and optionally a description for the new project.

· To update the existing project and convert it to Windows compatibility, deselect the Create a

new project option. If you deselect this option, it will not be possible to undo the changes that

will be made to the project.

4. Click Convert. For more information about converting Windows-legacy projects to Windows

compatibility, refer to UiPath Studio Guide.

Using ABBYY Vantage activities in UiPath workflow
The ABBYY Vantage Connector for UiPath lets your workflow send document images to ABBYY

Vantage and process it using an available skill. 

To view the available skills, create your own skills, or modify existing skills, use the ABBYY Vantage Skill

Catalog or ABBYY Vantage Skill Designer. Refer to ABBYY Vantage Skill Designer Guide for more

information on setting up skills.

The ABBYY Vantage Connector for UiPath delivers the following activities for working with ABBYY

Vantage:

· Vantage Scope

· Use Skill

https://docs.uipath.com/studio/docs/managing-activities-packages 
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· Get Results

· Map Fields

To add an activity to the UiPath process, drag the activity from the UiPath Studio Activities panel to the

Designer panel. After the activity has been added to the process, you will need to fill in the fields in the

Properties panel. You can fill in some of the properties in the Designer panel as well. For more details

about the properties of the activities, see the sections below.

The ABBYY Vantage Connector for UiPath is shipped with a sample process that demonstrates how

you can use ABBYY Vantage activities in your workflow. For more information, see the Sample process

for ABBYY Vantage activities section.

Vantage Scope Activity

The Vantage Scope activity passes ABBYY Vantage connection settings to other Vantage activities. It is

also a container for other Vantage activities. All other ABBYY Vantage activities must be placed inside the

Vantage Scope activity.

Note: The Vantage Scope activity allows to configure authentication using Resource Owner
Password Credentials Flow and Client Credentials Flow. If you set up an External Identity Provider in
Vantage, the only authentication flow that will work is the Client Credentials Flow.

For more information, see:

· Setting up an External Identity Provider: https://vantage-eu.abbyy.com/help/English/AdminGuide/?

topic=sysadmin_externalidentityprovider if you are in Western Europe, https://vantage-

us.abbyy.com/help/English/AdminGuide/?topic=sysadmin_externalidentityprovider if you are in

North America, and https://vantage-au.abbyy.com/help/English/AdminGuide/?

topic=sysadmin_externalidentityprovider if you are in Australia.

· Creating and configuring a client: https://vantage-eu.abbyy.com/help/English/AdminGuide/?

topic=admin_managingrestapiclients_createclient if you are in Western Europe, https://vantage-

us.abbyy.com/help/English/AdminGuide/?topic=admin_managingrestapiclients_createclient if you

are in North America, and https://vantage-au.abbyy.com/help/English/AdminGuide/?

topic=admin_managingrestapiclients_createclient if you are in Australia.

· Authentication flows: https://vantage-eu.abbyy.com/help/English/DevGuide/?

topic=developer_apiauthentication if you are in Western Europe, https://vantage-

us.abbyy.com/help/English/DevGuide/?topic=developer_apiauthentication if you are in North

America, and https://vantage-au.abbyy.com/help/English/DevGuide/?

topic=developer_apiauthentication if you are in Australia.

Activity properties

Group Property Type Description

Connection

Settings

Authorization

grant type

IEnumerable

<AuthorizationGr

antType>

The grant type that is used for authorization: 

· ResourceOwnerPassword 

· ClientCredentials 

https://vantage-eu.abbyy.com/help/English/AdminGuide/?topic=sysadmin_externalidentityprovider
https://vantage-eu.abbyy.com/help/English/AdminGuide/?topic=sysadmin_externalidentityprovider
https://vantage-us.abbyy.com/help/English/AdminGuide/?topic=sysadmin_externalidentityprovider
https://vantage-us.abbyy.com/help/English/AdminGuide/?topic=sysadmin_externalidentityprovider
https://vantage-au.abbyy.com/help/English/AdminGuide/?topic=sysadmin_externalidentityprovider
https://vantage-au.abbyy.com/help/English/AdminGuide/?topic=sysadmin_externalidentityprovider
https://vantage-eu.abbyy.com/help/English/AdminGuide/?topic=admin_managingrestapiclients_createclient
https://vantage-eu.abbyy.com/help/English/AdminGuide/?topic=admin_managingrestapiclients_createclient
https://vantage-us.abbyy.com/help/English/AdminGuide/?topic=admin_managingrestapiclients_createclient
https://vantage-us.abbyy.com/help/English/AdminGuide/?topic=admin_managingrestapiclients_createclient
https://vantage-au.abbyy.com/help/English/AdminGuide/?topic=admin_managingrestapiclients_createclient
https://vantage-au.abbyy.com/help/English/AdminGuide/?topic=admin_managingrestapiclients_createclient
https://vantage-eu.abbyy.com/help/English/DevGuide/?topic=developer_apiauthentication
https://vantage-eu.abbyy.com/help/English/DevGuide/?topic=developer_apiauthentication
https://vantage-us.abbyy.com/help/English/DevGuide/?topic=developer_apiauthentication
https://vantage-us.abbyy.com/help/English/DevGuide/?topic=developer_apiauthentication
https://vantage-au.abbyy.com/help/English/DevGuide/?topic=developer_apiauthentication
https://vantage-au.abbyy.com/help/English/DevGuide/?topic=developer_apiauthentication
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Password String The password used to connect to ABBYY

Vantage.

Secure

Password 

SecureString The secure password used to connect to ABBYY

Vantage.

Server URL String The ABBYY Vantage server address.

Tenant String The ABBYY Vantage tenant name or tenant

identifier.

Important! This property is only required if the
user whose credentials are used to connect to the
ABBYY Vantage server is registered in several
(more than one) tenants on the server.

The tenant name can be found on the Vantage

sign-in page in your browser when entering the

password.

Username String The user e-mail address used to connect to

ABBYY Vantage.

Proxy Settings

(optional) 

Enable Proxy Boolean Allows you to use a proxy server to route HTTP

requests.

Server URL String The proxy server address 

(e.g. http://127.0.0.1:8080).

Username String The username used to connect to the proxy

server.

Password String The password used to connect to the proxy

server.

Secure

Password

SecureString The secure password used to connect to the

proxy server.

Vantage Public

API Client

settings

(optional)

Client Id String Vantage application identifier.

Client Secret String Secure Vantage application key.

Secure Client

Secret

SecureString Secure Vantage application key as a secured

string.

Vantage user password, proxy password and Client Secret in the client settings can be set in the Scope

Activity either in a string parameter or in the corresponding parameter with the SecureString type.

A password of type String is stored as plain text in the XAML project file and it is not safe. A String

password is recommended for use only when configuring the Use Skill and Map Fields activities for

obtaining a list of skills, or for debugging your UiPath process. Once the process is fully configured:
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· If you use Resource Owner Password Credentials Flow, remove the Password property from the

Vantage Scope activity and set up the Secure Password property.

· If you use Client Credentials Flow, remove the Client Secret property from the Vantage Scope

activity and set up the Secure Client Secret property. 

We recommend using UiPath Orchestrator assets to securely store your credentials. In this case, the

password can be obtained from Orchestrator by means of the Get Credential activity and passed to

the Vantage Scope activity via a variable. For more details about the Get Credential activity, please

refer to the official UiPath guides.

Note: The same type of password must be used for Connection Settings, Proxy Settings and for
Client Settings.

When you create a client in ABBYY Vantage, configure the following in the OAuth 2.0 Flows Settings

section of the client settings, depending on the grant type you use:

· Resource Owner Password Credentials Flow:

o Enable the Allow Resource Owner Password Credentials Flow option.

· Client Credentials Flow:

o Enable the Allow issuing refresh tokens to refresh access tokens option. 

o Enable the Allow client credentials flow option. 

o Select the required roles with which the application will log in to Vantage by clicking the Manage

Roles setting. Important! If you need to select from the list one or more roles associated with

skills, also select the allowed skills for these roles. For more information about ABBYY Vantage

roles, see https://vantage-eu.abbyy.com/help/English/AdminGuide/?

topic=admin_rolebasedaccess if you are in Western Europe, https://vantage-

us.abbyy.com/help/English/AdminGuide/?topic=admin_rolebasedaccess if you are in North

America, and https://vantage-au.abbyy.com/help/English/AdminGuide/?

topic=admin_rolebasedaccess if you are in Australia.

https://docs.uipath.com/orchestrator/docs/about-assets
https://docs.uipath.com/activities/lang-en/docs/get-robot-credential
https://vantage-eu.abbyy.com/help/English/AdminGuide/?topic=admin_rolebasedaccess
https://vantage-eu.abbyy.com/help/English/AdminGuide/?topic=admin_rolebasedaccess
https://vantage-us.abbyy.com/help/English/AdminGuide/?topic=admin_rolebasedaccess
https://vantage-us.abbyy.com/help/English/AdminGuide/?topic=admin_rolebasedaccess
https://vantage-au.abbyy.com/help/English/AdminGuide/?topic=admin_rolebasedaccess
https://vantage-au.abbyy.com/help/English/AdminGuide/?topic=admin_rolebasedaccess
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Fields to be filled for the Resource Owner Password Credentials Flow:

Note: If all the properties in the Vantage Public API Client settings are empty, then the default ABBYY
Vantage client is used.

Fields to be filled for the Client Credentials Flow:

Proxy Settings

You can configure connector requests at runtime to go through a proxy server. The following proxy

authentication types are supported: Basic, NTLM, IP authentication, and transparent proxy.
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To use a proxy, select the Vantage Scope activity. In the Proxy Settings (optional) properties group,

set the value of the Enable Proxy property to "true" and then specify the address of your proxy server in

the Server URL property.

If you are using Basic authentication, in the Username and Password / Secure Password properties,

specify the proxy connection credentials.

If you are using NTLM authentication, the Username and Password fields are optional. If the Username

and Password fields are empty, the credentials of the user under which the UiPath process is running

will be used.

Use Skill Activity

The Use Skill activity creates a transaction for processing a document by means of an ABBYY Vantage

skill. A unique identifier of the transaction is then returned as the Transaction Id output property.

Activity properties

Group Property Type Description

Connection

Settings 

Skill Name String The name of the Vantage skill.

Input Input Files IReadOnlyDictio

nary<String,Inpu

tFile>

A Dictionary collection, where String is the name

of the file and InputFile is the class describing

the input file.

Note: Before adding files to the dictionary, it is
necessary to ensure that non-repeating values
are passed to the String parameter. You cannot
add more than one file to the Input Files dictionary
for which the same name will be passed in the
String parameter.

Transaction

Registration

Parameters

IReadOnlyDictio

nary<String,Strin

g>

A Dictionary collection of transaction registration

parameters to pass the key and value of each

parameter.

Output Transaction Id Guid The identifier of the created transaction.

This ID is then used as the Transaction Id input

property of the Get Results activity to get the

status of the transaction and the processing

results.

InputFile class properties:

Name Type Description

fileStream Stream The contents of the file that will be passed to ABBYY

Vantage.
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It is possible to pass the stream of the file on a local disk

as a value of this property (e.g.

System.IO.File.OpenRead("D:\images\Invoice1.pdf")).

index

(optional)

Integer The index number of the file in the transaction.

fileRegistrationParam

eters

(optional)

IReadOnlyDictionar

y<String,String>

A Dictionary collection of file registration parameters to

pass the key and value of each parameter.

Important!  The Use Skill activity can only be used inside a configured Vantage Scope activity.

When setting up the Use Skill activity, do the following depending on the authentication flow you use: 

· Resource Owner Password Credentials Flow—Specify the Password property of the Vantage

Scope activity to obtain a list of available skills. Once you have configured your UiPath workflow,

consider changing the Password property to Secure Password.

· Client Credentials Flow—Specify the Client Secret property of the Vantage Scope activity to

obtain a list of available skills. Once you have configured your UiPath workflow, consider changing

the Client Secret property to Secure Client Secret.

For more details, see the Vantage Scope Activity section.

Click the button to the right of the drop-down list under Skill Name to get a list of skills. Then expand the

Skill Name drop-down list and select the skill that you intend to use for document processing.
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Note: We recommend reducing the file size of big files to 30 MB or less to speed up document
processing.

Note: In the Skill Name parameter of the Use Skill activity, you can use a UiPath variable with String
type to store the name of the skill. When selecting a skill via the drop-down list of the activity on the
design panel, the newly selected skill will be written to the specified variable. You can store the name of
the skill directly in the variable. Expressions or references to other variables in the value of the variable
are currently not supported.

Get Results Activity

The Get Results activity is used to retrieve the processing results from ABBYY Vantage.

Activity properties

Group Property Type Description

Input Transaction Id Guid The identifier of the transaction. Pass to

this property the value obtained as the

output Transaction Id property of the Use

Skill activity.

Delete

Transaction

Boolean Specifies whether the completed

transaction should be deleted, whether

successful or not.

The default value of the property is FALSE,

which means that the transaction is not

deleted.

Output Document

Results

IEnumerable<Docu

mentResult>

A collection of result documents after

processing.

Review Link String A link to the ABBYY Vantage Manual

Review Client, where the transaction

results can be reviewed (this link can be

obtained only if the Process skill used

contains a Review activity).

Transaction

Status

TransactionStatus The status of the transaction. The following

statuses are possible: "New," "Processing,"

"Review," "Processed." 

Based on the status received, you can

configure your UiPath process to run a

different logic. For example, if the

transaction has the "Processing" status,

wait a few seconds and call the activity

again.

When using a Classification skill, Document skill, and OCR skill, all transaction input files will be

assembled into one document. When using a Process skill, multiple result documents can be obtained.
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By default, in the Process skill, a separate document is created in ABBYY Vantage for each input file

added to the transaction. Documents can be of different classes, but they will all be processed within

one transaction. You can also set your own document assembly settings using the Assemble Activity in

the Process skill. Thus, each transaction document will have its own processing results. The

Document Results output parameter of the Get Results activity receives the results of processing all

the documents of the transaction as a collection of instances of the DocumentResult class.

DocumentResult class properties:

Name Type Description

DocumentId String The identifier of the document. 

ClassificationConfide

nces

IEnumerable<Class

ificationConfidence

>

A collection of classification confidence values.

A list of all the classes available in the Classification skill

applied to the document, together with their classification

confidence values.

ClassName String The document class based on the classification results.

ExtractedData String A JSON string containing the extracted data.

Note: For a Process skill, the property can be obtained if
the Values, metadata, and field structure for each
document option is enabled in the Output Activity.

IsClassificationConfid

ent

Boolean The resulting class is deemed to have been determined

with confidence if this value is TRUE.

ResultFiles IReadOnlyDictionar

y<String,Stream>

A collection of result files after processing. 

DocumentFullText String The full-text layer of a document that has been captured by

ABBYY Vantage.

Note: If the skill configuration does not contain a full text
export setting, this property will contain the default value.

The default value of the property will contain the following

text: TXT export was not configured in the ABBYY

Vantage skill settings. Please enable TXT export in

the skill that you have selected.

Note: TXT export is only available for OCR or
Processing skills.

Note: All listed parameters are collected in a separate DocumentResult in the Document Results
collection. Even if there is only one output document, its output parameters will be available from the first
DocumentResult in Document Results collection.

ClassificationConfidence class properties:
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Name Type Description

ClassName String Vantage document class.

Confidence Int The degree of confidence that the document belongs to this

class. Possible values range from 0 to 100.

Important!  The Get Results activity can only be used inside a configured Vantage Scope activity.

If transaction processing is completed successfully (i.e. Transaction Status = "Processed"), the results

will be saved in the output properties.

If the transaction is still being processed (i.e. Transaction Status = "New" / "Processing"), wait a few

seconds and call the Get Results activity again.

A special case, where Transaction Status = "Review", is described below.

The results that the Get Results activity may obtain will vary depending on the skill applied to the

document.

· If a Classification skill is used (for example, Vantage Classifier), the following results will be

obtained:

o Transaction Status

o Document Results (for each DocumentResult)

· DocumentId

· ClassificationConfidences

· ClassName

· IsClassificationConfident

· ResultFiles (json file containing classification results data)

· If a Document skill is used (for example, Invoice US), the following results will be obtained:

o Transaction Status

o Document Results (for each DocumentResult)

· DocumentId

· ExtractedData

· ResultFiles (the results will be contained in two JSON files. The first file will contain all

document data. The second file will contain the values of the extracted fields and the rule

errors (if any). The name of the second file will end with "_fields.json")

· If an OCR skill is used, the following results will be obtained:

o Transaction Status
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o Document Results (for each DocumentResult)

· DocumentId

· ResultFiles (those files will be received the export to which is configured in the OCR skill)

· DocumentFullText (if export to TXT is enabled in the skill)

· If a Process skill is used, the obtained results will depend on the activities that make up the

Process skill and their settings, in particular the Output activity settings. For more information

about the Process skill, see https://vantage-eu.abbyy.com/help/English/SkillDesigner/?

topic=procskill_settingup if you are in Western Europe, https://vantage-

us.abbyy.com/help/English/SkillDesigner/?topic=procskill_settingup if you are in North America and

https://vantage-au.abbyy.com/help/English/SkillDesigner/?topic=procskill_settingup if you are in

Australia.

If a Process skill comprises a Classify activity and an Extract activity, the above results will be

obtained for both a Classification skill and a Document skill.

If a Process skill comprises multiple Classify or Extract activities, the results will be obtained for

the last activities of a particular type. For example, the JSON file returned by the Process skill

illustrated below will contain the extraction results from the Extract activity that is highlighted in red.

If the PDF option is enabled in the Exported Data Settings dialog of an Output activity of a

Process skill, the results will contain the JSON file with the extraction results and the document

image exported to a PDF file together with a text layer. For each transaction document, the

DocumentFullText parameter will be received if export to TXT is enabled in the skill.

A Process skill can also contain a Review activity. When using such a skill for document

processing, processing can be suspended if the document requires manual review. In this case,

the Get Results activity will obtain the following results:

o Transaction Status = "Review" 

o Review Link

Once the manual review and transaction processing are completed, you can obtain the above

results by calling the Get Results activity again.

Transaction processing may fail for a number of reasons (for example, an input file may be corrupted or

an input file format may not be supported by ABBYY Vantage). If this is the case, the Get Results

activity will throw an exception.

Map Fields Activity

The Map Fields activity is used to save extracted field values to UiPath variables. You can map ABBYY

Vantage fields to UiPath variables in the Designer panel.

https://vantage-eu.abbyy.com/help/English/SkillDesigner/?topic=procskill_settingup
https://vantage-eu.abbyy.com/help/English/SkillDesigner/?topic=procskill_settingup
https://vantage-us.abbyy.com/help/English/SkillDesigner/?topic=procskill_settingup
https://vantage-us.abbyy.com/help/English/SkillDesigner/?topic=procskill_settingup
https://vantage-au.abbyy.com/help/English/SkillDesigner/?topic=procskill_settingup
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Activity properties

Group Property Type Description

Connection

Settings

Skill Name String The name of the Vantage Document skill.

Input Extracted Data String Accepts a JSON string containing the extracted

data.

Pass to this property the value of the

ExtractedData property of the particular

DocumentResult received in the Get Results

activity. To pass values between the properties,

use UiPath variables.

Important!  The Map Fields activity can only be used inside a configured Vantage Scope activity. 

When setting up the Map Fields activity, do the following depending on the authentication flow you use: 

· Resource Owner Password Credentials Flow—Specify the Password property of the Vantage

Scope activity to obtain a list of available skills. Once you have configured your UiPath workflow,

consider changing the Password property to Secure Password.

· Client Credentials Flow—Specify the Client Secret property of the Vantage Scope activity to

obtain a list of available skills. Once you have configured your UiPath workflow, consider changing

the Client Secret property to Secure Client Secret.

For more details, see the Vantage Scope Activity section.

Note: At runtime, the Extracted Data property of the Map Fields activity must receive the value of the
ExtractedData property of the particular DocumentResult received in the Get Results activity
containing the data extracted by the Document skill for which the Map Fields activity has been
configured. After receiving the extracted data of the particular DocumentResult received in the Get
Results activity, check if the name of the Document skill applied to the document is the same as the
name of the Document skill for which the Map Fields activity has been configured, and if yes, pass the
extracted data to Map Fields. To obtain the document type (the same thing as the name of the
Document skill applied to the document), you may use the output ClassName property of the particular
DocumentResult received in the Get Results activity. To get the document type to this parameter, in
the Extract activity of the Process skill, configure the mapping of the class with the Document skill that
has to be used for document processing. When mapping, it is necessary to adhere to the condition that
the class name is equal to the name of the selected Document skill. For more information about the
setting up of the Extract activity, see https://vantage-eu.abbyy.com/help/English/SkillDesigner/?
topic=procskill_activity_extract if you are in Western Europe, https://vantage-
us.abbyy.com/help/English/SkillDesigner/?topic=procskill_activity_extract if you are in North America
and https://vantage-au.abbyy.com/help/English/SkillDesigner/?topic=procskill_activity_extract if you are
in Australia.

To map ABBYY Vantage fields to UiPath variables, complete the following steps:

1. Open the Map Fields activity in the Designer panel and click the button to the right of drop-down

list under Skill Name to get a list of available skills. 

https://vantage-eu.abbyy.com/help/English/SkillDesigner/?topic=procskill_activity_extract
https://vantage-eu.abbyy.com/help/English/SkillDesigner/?topic=procskill_activity_extract
https://vantage-us.abbyy.com/help/English/SkillDesigner/?topic=procskill_activity_extract
https://vantage-us.abbyy.com/help/English/SkillDesigner/?topic=procskill_activity_extract
https://vantage-au.abbyy.com/help/English/SkillDesigner/?topic=procskill_activity_extract
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2. Expand the Skill Name drop-down list and select the Document skill whose extracted field values

must be saved to UiPath variables.

Note: You can only choose a Document skill.

3. Click the Refresh button. A field tree will be displayed in the Vantage Extracted Field column. 

4. Expand the tree and click the Plus button next to a field that you want to map. In the UiPath

Variable column, a UiPath variable name and type will appear. By default, the name of the

variable will be the same as the name of the Vantage field, but you can change this name if

required. 

Note: Ensure that the UiPath variable names specified in the Map Fields activity match the Variables
Naming Convention configured in your UiPath process. If variable names do not follow the naming rules,
they will be displayed with a warning symbol in the UiPath variable list. For more about Variables Naming
Convention, see the UiPath documentation.

5. Repeat the previous step for all other fields that you need to map. When setting up mapping, you

can specify already existing UiPath variables. In this case, make sure that the type of your

variables matches the one recommended in the table below.

6. After you have mapped your document fields to UiPath variables, click Apply to save the changes.

Now when the Map Fields activity is called at runtime, variable values will be filled in with

extracted data.

https://docs.uipath.com/studio/docs/st-nmg-001
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Note: The specified UiPath variables will be created in the closest to the Map Fields activity
Sequence (for example, in Flowchart).

In the Skill Name parameter of the Map Fields activity, you can use a UiPath variable with String type to

store the name of the skill. When selecting a skill via the drop-down list of the activity on the design

panel, the newly selected skill will be written to the specified variable. You can store the name of the skill

directly in the variable. Expressions or references to other variables in the value of the variable are

currently not supported.

The table below shows what type of UiPath variable corresponds to each ABBYY Vantage field type.

ABBYY Vantage Field Type UiPath Variable Type

Text String

Date String

Number String

Money String

Barcode String

Checkmark Boolean

Checkmark group (can be obtained as separated

checkmarks)

FieldList

Group FieldList

Group (for repeatable groups) FieldList[]

Table FieldList[] 

Note: Table columns as well as repeating fields will be mapped to UiPath variables of type String[]. All
repeating fields and fields that are part of a repeatable group (or any other repeating fields and
repeatable groups within repeatable groups) will be mapped to UiPath variables of type FieldList[]. It is
also possible to map child objects of this group into variables of other simple types:
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 GroupItem class properties:

(GroupItem is a structure containing one instance of some repeating object (field or group of fields)

Method/Propert

y

Parameter Type Description

Keys IEnumerable<string> Key values. Each value is the

name of a specific nesting level. 

Values IEnumerable<IReadOnlyL

ist<FieldList>>

Set of field values of nesting

levels.

Count Integer Number of nested fields.

ContainsKey Key: String Boolean Specifies if a nested field exists.

TryGetValue Key: String, Value:

IReadOnlyList<FieldL

ist>

Boolean Specifies if a value exists.

If there is a value, returns True

and the value, otherwise returns

False.

this[] Name: String IReadOnlyList<FieldList> Returns the value of the specified

nested field.

Find Name: String IEnumerable<FieldList> Finds all nested fields of any

nesting level with the specified

name.

Filter Predicate: (Name:

String, Node:

IEnumerable<FieldList> Finds all nested fields of any

nesting level that satisfy the
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FieldList) => Boolean predicate.

Descendents NameItems: Params

String[]

IEnumerable<FieldList> Finds all nested fields of any

nesting level whose name

matches the nameItems

parameter.

FieldList class properties:

(FieldList is a structure that corresponds to a field or group of fields (repeating fields or repeating groups

with the same name) and contains the values (multiple instances possible) of the fields or groups)

Method/Property Parameter Type Description

Values IEnumerable<Object> Set of scalar field values.

Count Integer Number of nested GroupItems.

Find Name: String IEnumerable<FieldList

>

Finds all nested fields of any

nesting level with the specified

name.

Filter Predicate: (Name:

String, Node: FieldList)

=> Boolean

IEnumerable<FieldList

>

Finds all nested fields of any

nesting level that satisfy the

predicate.

this[] Num: Integer GroupItem Returns the GroupItem with

nested fields (if any) at the number

of the num parameter.

Note: The Sample Process provides an example of using a variable with the Fieldlist[] type (the
Description column of the LineItems table is displayed in the log messages).

For more information about the Group field type, see: https://vantage-

eu.abbyy.com/help/English/SkillDesigner/?topic=docskill_fields_group, https://vantage-

us.abbyy.com/help/English/SkillDesigner/?topic=docskill_fields_group or https://vantage-

au.abbyy.com/help/English/SkillDesigner/?topic=docskill_fields_group, depending on your region.

Sample process for ABBYY Vantage activities
ABBYY Vantage Connector for UiPath is shipped with a sample process that demonstrates how you can

use ABBYY Vantage activities in your workflow, how to configure your UiPath process to pass input data

to ABBYY Vantage activities, and how process data is received from ABBYY Vantage activities. A

sample process also shows how you can configure the connector to create a multi-file transaction in

ABBYY Vantage, set transaction and file registration parameters, and how you can process results from

several documents of one transaction.

Note: The sample process comes with Windows compatibility

https://vantage-eu.abbyy.com/help/English/SkillDesigner/?topic=docskill_fields_group
https://vantage-eu.abbyy.com/help/English/SkillDesigner/?topic=docskill_fields_group
https://vantage-us.abbyy.com/help/English/SkillDesigner/?topic=docskill_fields_group
https://vantage-us.abbyy.com/help/English/SkillDesigner/?topic=docskill_fields_group
https://vantage-au.abbyy.com/help/English/SkillDesigner/?topic=docskill_fields_group
https://vantage-au.abbyy.com/help/English/SkillDesigner/?topic=docskill_fields_group
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You can run this process and see how one person's Bank Statement and Utility Bill documents are

processed in a single transaction using the connector. The default location of the sample process is C:

\Users\Public\ABBYY Vantage Connector for UiPath\SampleWorkflow\Vantage.

The workflow will get input images from the predefined input location (\SampleWorkflow\Vantage\Input

images) and send it to ABBYY Vantage for processing. Once the processing is complete, some of the

processing results will be saved to \SampleWorkflow\Vantage\Results and others will appear in the

workflow log in the Output panel. The following processing results will be saved to

\SampleWorkflow\Vantage\Results:

· A subfolder with the name equal to the transaction ID will be created.

· In the transaction folder, a ResultFiles subfolder for saving all export files from all documents of

the transaction will be created. Each file name will have the prefix containing the identifier of the

document.

· Next to the ResultFiles folder, text files for storing the classification confidence values ​​and full-text

recognition result (ClassificationConfidences and DocumentFullText parameters) of each

document will be created. Each file name will have the prefix containing the identifier of the

document. 

In this sample, DocumentFullText will be filled with the default value and will not contain the results of

full-text recognition, because the Default Process skill used to create a transaction in the sample

process is not configured to export full-text recognition results to TXT. You can create a copy of the

Default Process skill, change the export file settings in the Output activity, publish the skill, and then use

it in the Use Skill activity.

Note: The TXT file containing the classification confidence values is just an example of how the
Classification Confidences value received by the Get Results activity can be processed. You do not
need to save results to TXT files.

The following processing results obtained by the Get Results activity will be displayed in the workflow

log in the Output panel:

· Document Class

· Is Classification Confident

· Values of UiPath variables

These values contain data for individual fields of the document, mapped into Map Fields activities

and filled while passing Map Fields activities when the process was executed. The process

contains two Map Fields activities, each for a different document type. 

The following fields are displayed in the log:

· Bank Statement:

o Bank Name

o Account Owner Name

o Ending Balance of the Period

· Utility Bill:
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o Customer Name

o Issuer Name

o Bill Date

o Current Charges

o Description column from the LineItems table

For more details about getting processing results, see the Get Results Activity section.

Running the sample process

To run the sample process, complete the following steps:

1. Copy the folder containing the sample process (C:\Users\Public\ABBYY Vantage Connector

for UiPath\SampleWorkflow) into any folder accessible to the user running UiPath Studio.

2. In UiPath Studio, open the Main.xaml file.

3. In the variables listed bIn the Design tab, double-click the Send Files to ABBYY Vantage

sequence and open the Variables panel.elow, specify the address of the ABBYY Vantage server

and the credentials that were used to register your ABBYY Vantage account:

o VantageServerUrl

o VantageUserName

o VantagePassword

o VantageTenant (if your user is in multiple tenants)
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4. Run the workflow by clicking Debug File > Run File or by pressing Ctrl + F5.

Once you have completed the above steps, the workflow will send documents to ABBYY Vantage for

processing. 
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